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File Menu

The File menu includes commands that enable you to open and save files, to batch convert 
files to JPEG, and to display multiple images in a selected order.

For more information, select the File menu command name.

Open
Save
Save as
Save All Options
Delete
Batch Compression
Slideshow
Print
Print Setup
Print Options
1, 2, 3, 4
5, 6, 7, 8
Exit



Edit Menu

The Edit menu includes commands that enable you to transfer images to and from the 
clipboard, to change the color components of an image, and to manipulate the image.

For more information, select the Edit menu command name.

Undo
Redo
Copy
Paste
HSV Adjustment
Color Balance
Contrast Enhancement
Gamma Correction
Grayscale
Negative
Rotate
Flip Horizontal
Flip Vertical
Resize
Crop



Capture Menu

The Capture menu includes commands that let you capture the entire screen, a part of the 
screen, a window, or a part of a window.

For more information, select the Capture menu command name.

Window
Client Area
Desktop
Area of Desktop
Hide Window



Options Menu

The Options menu includes commands that let you determine how other commands operate.
The settings for the options can be saved with the Save All Options command.

For more information, select the Options menu command name.

Full Palette
Stretch to Fit Window
Keep Aspect Ratio if Stretched
View Fullscreen
Maximum Color Depth
Auto-resize
Show Scroll Bars
Move Window after Load
Suppress Warnings
Disable Undo
JPEG Options
Memory Options
Slideshow Options



File Open command (File Menu)

Select the name of a file to display.    The file formats that are supported are the JPEG File 
Interchange Format (JFIF), TIFF, GIF 87a/89a, Targa, PCX, OS/2 or Windows BMP, and PPM.    
Selecting the JPEG Preview file type will display a JPEG image as a grayscale image.

The Info button will display the image and file attributes of a selected file.



File Save command (File Menu)

Save the displayed image with the same filename and the same file format as the opened 
file.    If the file format is not supported in the save feature, the save dialog will appear and it 
will let you choose a supported format.    When you save an image, the color depth of the 
output file is either 8 or 24 bits per pixel.    If the displayed image has at most 256 colors, the
output color depth is 8 bits per pixel.    If it has more than 256 colors, the output color depth 
is 24.    These restrictions do no apply if the color depth of the output file format is fixed 
(e.g., JFIF, PPM, or GIF).



File Save As command (File Menu)

Select the name of the output file and the output format, which is the JPEG File Interchange 
Format(JFIF), LZW compressed or uncompressed TIFF, GIF 87a, uncompressed Targa, PCX, 
Windows or OS/2 BMP, or PPM.    When you save an image, the color depth of the output file 
is either 8 or 24 bits per pixel.    If the displayed image has at most 256 colors, the output 
color depth is 8 bits per pixel.    If it has more than 256 colors, the output color depth is 24.    
These restrictions do no apply if the color depth of the output file format is fixed (e.g., JFIF, 
PPM, or GIF).



Save All Options command (File Menu)

This will save all the WinJPEG options to a file named "winjpeg.sav" in the same directory as 
the WinJPEG executable.    When WinJPEG is initially loaded, the options will be loaded if 
"winjpeg.sav" exists.



Delete command (File Menu)

This menu command lets you delete the file containing the currently displayed image.    
WinJPEG will prompt you for confirmation before deleting the file.    To delete an image during
a slideshow, press the Delete key.



Batch Compression command (File Menu)

Select GIF, TIFF, Targa, or PPM files to compress to JPEG FIF format with the options specified
in the JPEG Options dialog box.    The list box on the left displays the files in the current path 
and the list box on the right displays a list of files to be converted.    To add files to the latter 
box, select the files you want to convert and press the Add button.    The Select All and 
Unselect All buttons let you quickly select and unselect, respectively, all of the files in the 
list box.    To remove files from this list box, select the desired files and press the Remove 
button.

Once you have chosen the files that you want compressed, you can start the batch 
compression by pressing the OK button.

If you decide to abort the conversion while it is in the process of converting, click on the 
window with the left mouse button, click on the "Yes" button in the confirmation dialog, and 
the conversion will halt after the current file is completed.    The output files will have the 
same name as the input files except that they will have a ".jpg" extension.    Also, the output 
files will be placed in the same directory path in which the input files were located.

See also JPEG Options.



Slideshow command (File Menu)

To select JPEG, TIFF, GIF, Targa, OS/2 or Windows BMP, PCX, or PPM files to display in a 
slideshow, select the desired files in the Files list box and press the Add button.    The order 
in which you add the selected files to your slideshow list determine the order in which they 
are displayed if the Slide Order is set to Forward or Reverse in the Slideshow Options dialog 
box.      Files can be removed from the slideshow list by selecting files in the slideshow list 
and pressing the Remove button.

Once you have chosen the files in your slideshow, you can start the slideshow by pressing 
the OK button.    To advance to the next file while WinJPEG is pausing, click on the window 
with the right mouse button.    To abort the slideshow, click on the window with the left 
mouse button, click on the "Yes" button in the confirmation dialog, and the slideshow will 
stop after the currently loading picture is displayed.

See also Slideshow Options.



Print command (File Menu)

Print the image currently displayed.      The Print dialog box lets you specify the Print 
Quality and the number of Copies to print.    The Print Setup dialog can be accessed before 
printing.



Print Setup command (File Menu)

The Print Setup dialog box lets you select the Printer, page Orientation, and Paper 
options.    The Options dialog box allows printer driver-dependent options to be changed.    



Print Options command (File Menu)

The displayed image can be printed in three ways: 1) best fit for the page, 2) fit for the full 
page, or 3) scaled by a user-selected factor.    Best Fit scales the image for maximum fit on 
a printed page while maintaining the image's aspect ratio.    Fit for Full Page scales the 
image such that it fits the entire page.    The Scale option scales the printed image's width 
or height by an integer factor that is selected by the user.



1, 2, 3, 4 commands (File Menu)

The four most recently used file paths and their respective file types for viewing an image.     
If you select one of these menu items, the open dialog will be displayed with a list of files 
limited to the selected file type in the corresponding file path.



5, 6, 7, 8 commands (File Menu)

The four most recently opened images.    Choosing one of these menu-items re-opens the 
selected file.



Exit command (File Menu)

Exit from WinJPEG.    While WinJPEG is compressing/decompressing an image, you can exit by
using the Close command in the system menu.



Undo command (Edit Menu)

Reverses the last change made to an image.    If your system is low on memory, you can turn
off the undo feature with the Disable Undo option.



Redo command (Edit Menu)

Restores the last change that was "undo'ed."



Copy command (Edit Menu)

If a region of the image is selected (see Selecting a Region to Crop or to Copy), copy that 
region into the clipboard.    Otherwise, copy the entire image into the clipboard.    WinJPEG 
posts the image in Windows bitmap and Device-Independent Bitmap(DIB) formats.



Paste command (Edit Menu)

Paste an image from the clipboard.    The clipboard must contain either a Windows bitmap or 
a Device-Independent Bitmap(DIB).



Crop command (Edit Menu)

If a region of the image is selected (see Selecting a Region to Crop or to Copy), keep that 
region and discard the image outside of    the selected region.



HSV Adjustment command (Edit Menu)

Use the scroll bars to adjust the amount of hue, saturation, and value/brightness in an 
image.    A value of 0 on the scroll bar means that there is no change in the corresponding 
color component.    When the value is increased or decreased, the color component is 
increased or decreased, respectively.



Color Balance command (Edit Menu)

Use the scroll bars to adjust the amount of red, green, and blue in an image.    A value of 0 
on the scroll bar means that there is no change in the corresponding color component.    
When the value is increased or decreased, the color component is increased or decreased, 
respectively.



Contrast Enhancement command (Edit Menu)

Use the scroll bar to adjust the amount of contrast in an image.    A value of 0 on the scroll 
bar means that there is no change in the contrast.    When the value is increased or 
decreased, the contrast is increased or decreased, respectively.



Gamma Correction (Edit Menu)

Use the scroll bar to adjust the amount of gamma.    A value of 1.0 on the scroll bar means 
that there is no change in the image.    In general, increasing the gamma makes the image 
lighter and decreasing it makes the image darker.    A gamma of 2.2 is a commonly used 
value.



Grayscale command (Edit Menu)

Convert a color image into a grayscale one.



Negative command (Edit Menu)

Obtain the negative of the image.



Rotate command (Edit Menu)

Rotate the image clockwise by 90 degrees.



Flip Horizontal command (Edit Menu)

Flip the image around the vertical axis.



Flip Vertical command (Edit Menu)

Flip the image around the horizontal axis.



Resize command (Edit Menu)

Change the spatial resolution of the displayed image.    Common sizes such as 640x680, 
800x600, 1024x768, and 1280x1024 can be easily selected.    The Maximize Fit on 
Desktop option will resize the image into the largest possible window that will fit on the 
desktop while keeping the aspect ratio, the ratio between the original width and height.    
Also, a custom size can    be manually entered.    If Keep Aspect Ratio is enabled, only one 
dimension needs to be entered because the other one is automatically changed to maintain 
the aspect ratio.



Window command (Capture Menu)

After selecting this menu item, the WinJPEG window hides itself and you must select a 
window to capture by moving the mouse pointer over the desired window and clicking on 
the window with the left mouse button.    Some examples of a capturable window are a 
window frame, a tool bar, an icon, etc.



Client Area command (Capture Menu)

After selecting this menu item, the WinJPEG window hides itself and you must select a client 
area of a window to capture by moving the mouse pointer over the desired window and 
clicking on the window with the left mouse button.    The client area does not include the 
window frame or menu bar.



Desktop command (Capture Menu)

Capture the entire desktop.    See also the Hide Window option.



Desktop Area command (Capture Menu)

After selecting this menu item, you must select an area of the desktop to capture.    To select 
a region of the desktop, click on the desktop with the left mouse button.    While holding 
down that button, move your mouse until the rectangle surrounds the desired region, and 
then release the mouse button.    The dimensions of the selected region are displayed in the 
center of the indicated region.    See also the Hide Window option.



Hide Window command (Capture Menu)

When this option is checked, the WinJPEG window hides itself before capturing the desktop 
with the Desktop or Area of Desktop command.



Full Palette command (Options Menu)

Windows normally reserves 19 system colors for painting display elements like the 
background color, window frame color, etc.    If this option is checked and you are using a 
256-color display mode, these colors are no longer reserved by the system and the image is 
displayed with the image's full palette of colors.    However, the system colors will look 
incorrect until you turn this option off or exit WinJPEG.

If the option is off, Windows attempts to match system colors to colors in the image's palette
before reserving the colors it needs.    In other words, if it can't find the system colors in the 
image's palette, it will replace image palette entries with system colors.    Up to 19 colors in 
the image could be replaced by the system colors.

The Full Palette option is available in 256-color mode only.



Stretch to Fit Window (Options Menu)

When this option is checked, the scroll bars for the WinJPEG window are turned off and the 
image is stretched to the dimensions of the client area of the WinJPEG window.    This option 
does not permanently change the resolution of the image.    If you save the image, the 
original image is saved, not the stretched one.



Keep Aspect Ratio if Stretched (Options Menu)

When this option is checked along with Stretch to Fit Window, the image is stretched while 
maintaining the image's aspect ratio.



View Fullscreen (Options Menu)

View the currently displayed image with the full screen.    If the image is larger than the 
entire screen, the image will be resized with the best proportional fit before it is displayed.    
If the image is smaller, it will be displayed in the center of the screen.    To exit from full 
screen mode, press any key or click on the screen with the left mouse button.



Maximum Color Depth command (Options Menu)

When you load or paste an image that has more colors than the Maximum Color Depth 
setting, WinJPEG will reduce the number of colors to the Maximum Color Depth setting 
before displaying the image.    If you are viewing images, you should set this option to the 
number of colors supported by your display driver.    If you are converting images from one 
file format to another, you should set it to 16.7 million colors.



Auto-resize command (Options Menu)

When this option is checked, WinJPEG will automatically resize the window so that the image
will fit just inside the window.    When an image is initially loaded, the window size is changed
so that the largest possible portion of the image is displayed.    When you change the window
size so that it is larger than the image size, the window will    be resized so that it just fits 
around the image.    Also, scroll bar(s) are activated if they are needed.



Show Scroll Bars command (Options Menu)

This option is available only if auto-resize is off.    It lets you choose whether or not the scroll 
bars are activated.



Move Window after Load command (Options Menu)

If this option is checked, the WinJPEG window is moved to the upper left-hand corner of the 
desktop after an image is loaded.



Suppress Warnings command (Options Menu)

If this option is checked, WinJPEG suppresses all warnings.    Warnings occur when you load a 
corrupted image, discard an image that has changed, or save an image that has lost data 
because of quantization or dithering.



Disable Undo command (Options Menu)

If this option is checked, you will not be able to undo any changes to an image.    Use this 
option if your system is low on memory or if you don't need to undo changes to an image.



JPEG Options command (Options Menu)

The Quantization options are applied when Maximum Color Depth is set to 8-bits per 
pixel or less.    2-pass quantization(specifically, Heckbert) calculates the optimal color map 
for the quantized image and produces better looking output than 1-pass quantization.    1-
pass quantization is slightly faster because a fixed color map is used.

Dithering is the process of rendering an image on a display that supports less than the 
number of colors in the image.    Floyd-Steinberg Dithering, an error diffusion method, 
should be turned on when your display is not truecolor(24-bit) and when Maximum Color 
Depth is set to the number of colors supported by your display driver.

The Quality Factor, an integer between 0 and 100 inclusive, determines the tradeoff 
between the output file size and the output image quality.    If you choose a high quality 
factor, the image quality will be high but the file size will be large.    A lower quality setting 
will yield a smaller file at a cost of lower fidelity.    Since the JPEG algorithm is lossy, a quality 
factor of 100 will not give you a losslessly compressed image.

The Smoothing Factor, also an integer between 0 and 100 inclusive, determines the 
degree of smoothing to apply to an image before compressing that image with JPEG.    The 
higher you set the factor, the higher the degree of smoothing that is applied.    A smoothing 
factor of 0 means that no smoothing is performed.    Smoothing removes noise introduced 
when an image is dithered, and, in turn, smoothing produces a smaller JPEG file.    It should 
be used for only dithered images, like photographic GIF pictures.    Generally, a factor 
between 10 and 50 removes the dithering noise from an image.

Entropy Optimization produces a smaller JPEG file but it takes more time to encode the 
image. 



Memory Options command (Options Menu)

When WinJPEG needs more memory, it can use virtual memory, selected by the Available 
Memory button, or it can use temporary files, selected by the Temporary File button.    If 
the former option is selected and WinJPEG runs out of virtual memory, temporary files will 
automatically be used.

Temporary files are created in the directory chosen by the user and they are deleted when 
WinJPEG is done with the memory or when the user aborts decompression/compression of an
image by closing the program.

In general, the Available Memory should be selected when your system has at least 8 Mb 
of RAM, and the Temporary File should be selected when you have little RAM or you are 
multitasking memory-intensive programs.



Slideshow Options command (Options Menu)

The Slide Order determines the order in which the images in a slideshow list is displayed.    
If Forward order is selected,    the images are displayed in the order in which they are listed 
in the slideshow dialog box.    If Reverse order is chosen, the images are displayed in 
reverse order from the last file to the first one in the slideshow list.    If Random order is 
selected, the files are displayed in a random order.

The Slide Advancement options determine how to advance to the next image in a 
slideshow.    In Manual mode, WinJPEG will wait until you click with the right mouse button 
before advancing to the next picture.    In Automatic mode, there will be a user-selected 
time delay before the next picture is loaded.    To advance to the next picture before the 
delay has elapsed, click on the window with the right mouse button.    The Delay can be set 
to a value between 0 and 60 seconds.

The Buffer Image Formats options allow buffering of selected image formats during a 
cyclic slideshow.    If a type is selected, all images of that type are stored in memory after 
they are loaded and decompressed, and they will not be loaded/decompressed the next time
they are displayed.    This feature must be used in conjunction with the Cycle Slideshow 
option.    Buffering images can use a lot of memory; if you don't have much physical 
memory, be certain that there is enough disk space on Window's swap drive to handle this 
memory usage.

When a slideshow is running, the Cycle Slideshow option determines whether or not a list 
of images are continuously displayed in a cycle.    If this option is on, the slideshow returns 
back to the first picture after the last one is displayed and continues to display all the 
images in a selected list until you abort the slideshow.

The Fullscreen option lets you display the images in the slideshow with the full screen as 
described in the View Fullscreen section.



JPEG

Joint Photographic Experts Group (JPEG)    refers to a still-picture compression standard that 
specifies several modes of operation.    The mode used by the Independent JPEG 
Group's(IJPEG) software, which is incorporated into WinJPEG, is sequential buildup;    in this 
mode,    each component of an image is encoded in a left-to-right and top-to-bottom scan.    
Sequential mode is lossy, which means that when you compress an image, you will lose 
information.    That is, when you decode the compressed image, the decoded image will not 
exactly match the original.    One reason that sequential mode JPEG is lossy is that the 
algorithm compresses an image by removing visually insignificant information, colors that 
the human eye cannot detect.



Image File Formats

For more information, select an image file format.

JPEG File Formats
Tagged Interchange File Format (TIFF)
Graphics Interchange Format (GIF)
Targa
PCX
Windows BMP and OS/2 BMP
Portable Pixmap (PPM)



JPEG File Formats

The JPEG committee has not specified a standard file format, and consequently, many 
applications of the JPEG algorithm use their own proprietary format.    WinJPEG uses the JPEG 
File Interchange Format(JFIF) which transports only pixel information.    JFIF is supported by 
the IJPEG Group's software and other programs based on their code.

Handmade Software's GIF2JPG and Image Alchemy by default use a proprietary JPEG format 
that is not compatible with the JFIF standard.    This proprietary format is not supported by 
WinJPEG.    When you use GIF2JPG, remember to use the "-j" option to produce a JPEG file 
that is compatible with the JFIF standard and viewable with WinJPEG.

However, the GIF2JPG's "-j" option doesn't always produce a file in JFIF.    If you have to use a 
DOS converter,    we recommend that you use the IJPEG Group's cjpeg program.      Otherwise,
you should use WinJPEG's Batch Compression feature, which performs the same task as 
cjpeg except that only GIF, PPM, TIFF, and Targa images are supported.



Tagged Interchange File Format (TIFF)

WinJPEG supports a subset of the TIFF 6.0 specification.    WinJPEG can view TIFF files stored 
with 1, 2, 4, 8, or 24 bits per pixel.    WinJPEG can read TIFF images stored in strip format, in 
which the image is divided into horizontal strips of pixels, and tile format,    in which an 
image is divided into rectangular grids of pixels.    The compression modes LZW and Packbits 
can be read as well as uncompressed TIFF images.

WinJPEG can save uncompressed or LZW compressed TIFF files with 8 or 24 bits per pixel.    
TIFF files are saved in strip format.



Graphics Interchange Format (GIF)

WinJPEG can view interlaced/non-interlaced GIF87a and GIF89a files and it can save non-
interlaced GIF87a files.    If a GIF89a file contains more than one image, it will display the 
first image in the file.



Targa

WinJPEG can view Targa files stored with 8, 15, 16, 24, or 32 bits per pixel and it can save 
uncompressed Targa files with 8 or 24 bits per pixel.



PCX

WinJPEG can view PCX files stored with 1, 4, 8, or 24 bits per pixel.    If a 1, 4, or 8 bits per 
pixel PCX file does not have a valid palette, WinJPEG will use a default palette.    It can save 
PCX Version 3.0 files with 8 or 24 bits per pixel.



Windows BMP and OS/2 BMP

WinJPEG can view Windows and OS/2 (1.x and 2.0) files stored with 1, 4, 8, or 24 bits per 
pixel and can view BMP files that are run-length encoded(RLE).    In addition, it can display 
the first image in an OS/2 (1.x and 2.0) bitmap array.    It can save uncompressed Windows or
OS/2 (1.x and 2.0) BMP files in 8 or 24 bits per pixel and can save BMP files with RLE.

Note that some graphics viewers use the file extension ".RLE" for run-length encoded 
Windows BMP files.    WinJPEG uses the ".BMP" extension as a default for such files.



Portable Pixmap (PPM)

WinJPEG can view Portable Pixmap(PPM) and Portable Graymap(PGM) files.    It can save a 
subtype of the PPM format in which the pixel values are stored in binary.    The color depth of 
this subtype is always 24 bits per pixel.



How to Register

If you use WinJPEG for more than 14 days, you are expected to register WinJPEG.    When you
register, you will receive the latest 286 and 386 versions of WinJPEG, a user manual, and a 
collection of JPEG images (we will put as many as we can fit on 1 1.44M 3 1/2" floppy or on 4
360k 5 1/4" floppies).    Also, the registered version does not have the reminder-to-register 
screen at the start.

The registration fee is $25.    Massachusetts residents, add 5% sales tax to the registration 
fee.    US residents, add $4 for shipping and handling; non-US residents, add $8 for shipping 
and handling.    If you want WinJPEG e-mailed to your account instead of having it physically 
mailed to you, there is no extra shipping charge.    If you are paying with a Visa or 
MasterCard, add 10% to this subtotal.    The 10% is the processing fee that we get charged 
for credit card transactions.

Registered users of WinJPEG can purchase the latest version for $5.    Shipping and handling 
fees described above apply to these updates as well.    Updates are available when you see a
new shareware version.

For e-mail registrations, you need to use a program called "uudecode" to decode the 
uuencoded file that we e-mail to you.    For your information, a uuencoded file is a binary file 
that is converted to text by a program called "uuencode."    If your mail system rejects large 
messages, we will split the uuencoded file into smaller parts before mailing the parts to you, 
and you will need to edit the messages with a text editor before you can decode them.    
Compuserve, America Online, and Prodigy, for example, do not permit large e-mail 
messages.    Also, the uuencoded file is rather large; it's approximately 1 MB for WinJPEG.    
Compuserve users may find it less expensive to receive WinJPEG via U.S. Mail.

Registrations with the incorrect fee or with non-US currency will be returned.    Foreign 
registrations must send US currency or a check drawn from a US bank.

To register, complete the Order Form and send payment to:

            Norman Yee
            58 Chandler St.
            Boston, MA 02116
            U.S.A.



To print this form, select the File_Print Topic menu item.  If
you wish to type your order, edit the ORDER.FRM file that is
distributed with the shareware version and print it.

                              ORDER FORM
 Name: ______________________________________________________________
 Address: ___________________________________________________________
 City: _____________________  State: ________  ZIP: _________________
 Country (if outside US): ___________________________________________
 Phone Number (optional): _____________  Circle:  home  or  work
 Shareware Version of Program evaluated (optional): _________________
 Where you found Shareware Version (optional): ______________________
  Product                       Quantity     Price Each         Total
  ===================================================================
  PMJPEG for OS/2 2.x             ____       $20.00 U.S.        _____
  WinJPEG for Windows 3.x         ____       $25.00 U.S.        _____
  WinJPEG Update Fee (from any registered version of WinJPEG)
                                  ____        $5.00 U.S.        _____
  ===================================================================
                                            Merchandise Total: ______
                 5% Sales Tax  (Massachusetts residents only): ______
                           Shipping and Handling (choose one): ______
                            __  E-mail (no additional charge)
                            __  U.S. residents ($4 U.S.)
                            __  Non-U.S. residents ($8 U.S.)
                                                     Subtotal: ______
              For Visa/MasterCard Orders, add 10% of Subtotal: ______
                                                        TOTAL: ______
   (Non-credit card order payments must be in U.S. cash,
    U.S. funds drawn on a U.S. bank, or a postal money order)
  Please fill in the following for Credit Card Orders:
      Signature: _______________________
      Name on Card: ____________________       Visa [ ]   MasterCard [
]
      Credit Card Number: ___________________   Expiration Date: 
_______
  Choose Disk Size (check one if you did not select "E-mail" for 
shipping):
                      __  5 1/4" DS/DD (360K) disk
                      __  3 1/2" DS/HD (1.44 MB) disk
  E-mail Address (optional except E-mail Shipping): _________________
  Circle Type of Email Address:  Internet  Compuserve  AOL  Delphi
 Mail to:                  Internet Address:
         Norman Yee                        nyee@osiris.ee.tufts.edu



         58 Chandler St.                   kenyee@ksr.com
         Boston, MA 02116
         U.S.A.



Reporting Bugs

If you find a bug in WinJPEG, we would appreciate it if you would inform us of the bug 
through one of our e-mail accounts:

Norman Yee Ken Yee
nyee@osiris.ee.tufts.edu kenyee@ksr.com

When you send us a bug report, include a description of    the procedure for reproducing the 
bug and a description of your system configuration(hardware and software).



License Agreement (applicable to registered users)

You are licensed to single-copy use of WinJPEG; this means that you can install your 
registered version of WinJPEG simultaneously on one computer at work, one computer at 
home, and one portable computer, if only one copy is in use by the registered individual at a
time.    You may make copies of the registered WinJPEG disk as necessary for normal backup 
purposes; you agree not to make any copies of the printed WinJPEG manual or the registered
version of WinJPEG for others. 



Disclaimer

The authors of this program accept no responsibility for damages that are caused by this 
program and make NO WARRANTY or representation, either express or implied, with respect 
to this software.    This software is provided "AS IS," and you, its user, assume the entire risk 
when you use it.
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WinJPEG Features

WinJPEG v.2.5 is a shareware image viewer with image processing and conversion 
capabilities    for Microsoft Windows 3.x.    It has the following features:

· display JPEG, TIFF, Targa, GIF, PCX, OS/2 BMP, Windows BMP, or PPM images
· export an image to JPEG, TIFF,    Targa, GIF, PCX, OS/2 BMP, Windows BMP, or PPM format
· display an image in monochrome, 16 color, 256 color, hicolor, or truecolor display modes
· display an image with its full palette
· display an image in full screen mode
· print an image with scaling or with best proportional fit on the page
· red/green/blue or hue/saturation/brightness adjustment
· color to grayscale conversion or image negative conversion
· gamma correction
· image rotation, vertical or horizontal flip, image resizing, and image cropping
· batch file compression of GIF, TIFF, Targa, or PPM files to JPEG File Interchange Format (JFIF)
· slideshow: display selected files in forward, reverse, or random order with a cycle option
· image buffering in a cyclic slideshow
· copy a portion of or the entire image    to the clipboard, paste an image from the clipboard
· capture a window, the client area of a window, or a portion of or the entire desktop
· support for Windows 3.1 features like drag-drop and common dialogs
· support for file name extension association and starting a slideshow from the command 

line

There are two versions of WinJPEG: a 386 version for 386's or better and a 286 one for 286's 
or better.    The shareware version is a fully functional 286 version.    The 386 version can be 
obtained by registering WinJPEG.    See How to Register for more information.



Drag-drop Support

If you are using Windows 3.1, when you drag one or more files from File Manager to an open 
WinJPEG and drop them there, WinJPEG will automatically enter the slideshow mode and 
display those files in the order in which they are listed in File Manager.    There is a delay, 
which can be set in the Slideshow dialog box, between displayed pictures.



Selecting a Region to Copy or to Crop

To select a region of the image,    click on the image with the left mouse button.    While 
holding down that button, move your mouse until the rectangle surrounds the desired 
region, and then release the mouse button.    The dimensions of the selected region are 
displayed in the center of the indicated region.



Converting File Formats with WinJPEG

Images can be converted from one file format to another by loading an image with the File 
Open menu item and saving it to the desired file format with the File Save As menu item.    

Before you load an image that you want to convert, you should set the Maximum Color 
Depth option to 24-bit if you don't want the image degraded.    If the color depth of the 
image is greater than the Maximum Color Depth setting, the color depth of the image is 
reduced to this setting before it is displayed.    In this process, colors are lost, and noise is 
introduced into the image by dithering.    Setting Maximum Color Depth to 24-bits per 
pixel before loading the image ensures that there is no color reduction.    However, if you 
want to save the image as it is displayed on your screen, you can leave the Maximum 
Color Depth set to the number of colors supported by your display driver.

WinJPEG saves a displayed image to the selected file format with 8-bits per pixel or 24-bits 
per pixel. If the displayed image has at most 256 colors, the output color depth is 8 bits per 
pixel.    If it has more than 256 colors, the output color depth is 24.    These restrictions do not
apply if the color depth of the output file format is fixed (e.g., JFIF, PPM, or GIF).

When WinJPEG quantizes or dithers an image for display, information in that image is lost 
and WinJPEG will warn you when you try to save that image.

Images can also be compressed with baseline sequential JPEG by using the Batch 
Compression feature, which is useful for converting multiple files to JFIF format.    Note that 
this feature is not affected by the Maximum Color Depth setting.



Notes about OS/2 2.0

When you run WinJPEG under OS/2 2.0, WinJPEG cannot allocate more than 1 Mb of 
contiguous memory at a time.    Because of this limitation in OS/2 2.0, WinJPEG cannot 
allocate enough contiguous memory if the image is too large.    In addition, this limitation will
cause the JPEG code to use temporary files most of the time.    OS/2 2.1 allows Windows 
applications to allocate more than 1 Mb of contiguous memory and it fixes this problem.



Keyboard Accelerators
WinJPEG lets you use the following key combinations to perform the corresponding functions.

Key(s) Function
Del Delete File
Alt + Backspace    or    Ctrl + Z Undo Changes
Alt + Shift + Backspace    or    Ctrl + R Redo Changes
Ctrl + Ins    or    Ctrl + C Copy Image to Clipboard
Shift + Ins    or    Ctrl + V Paste Image from Clipboard
Home Scroll Left by a Page
Up Arrow Scroll Up by One Pixel
Page Up Scroll Up by a Page
Left Arrow Scroll Left by One Pixel
Right Arrow Scroll Right by One Pixel
End Scroll Right by a Page
Down Arrow Scroll Down by One Pixel
Page Down Scroll Down by a Page



Command Line Slideshow

A slideshow can be initiated from the DOS or Windows command line by adding a list of files 
after the winjpeg.exe in the command line.    For example, if you are starting WinJPEG and 
Windows 3.x from the DOS command line, type following command at the DOS prompt to 
display the three files, "mirri3.jpg, "mirri4.jpg," and "ksc.jpg":

win winjpeg.exe mirri3.jpg mirri4.jpg ksc.jpg

This example assumes that "winjpeg.exe" is in your search path and this command is 
executed in the directory containing the images.    If this is not the case, standard DOS paths 
can be inserted in front of the filenames.

If you are already running Windows, you can start a command line slideshow from the 
Program Manager's or File Manager's File Run menu command.    For example, to display the 
above files in a slideshow, type the following in the Command Line edit box:

winjpeg.exe mirri3.jpg mirri4.jpg ksc.jpg

The slideshow options last saved in WinJPEG will be used for the slideshow started from the 
command line.




